What’s New in Centricity® Practice Solution
Version 12
March 2014
What’s New in.....

Centricity® Practice Solution 12

December 2013

New features and enhancements in Centricity Practice Solution 12!

Centricity Practice Solution is a fully integrated Electronic Medical Record and Practice Management system designed to enhance the clinical and financial productivity of your ambulatory practice. With exceptional customization, progressive technology, and seamless interoperability, CPS enables you to spend more time with patients.

ONC Meaningful Use/CCHIT 2014® requirements fulfilled!

Centricity Practice Solution v12.0 was certified as a Complete EHR for Ambulatory on 11/27/2013 (CHPL Product ID: CC-2014-704359-1) including Clinical Quality Measures (CMS 69, 117, 125, 126, 138, 147, 148, 165, 166), and used the following additional software during testing (Required: Centricity ePrescribing, Centricity Clinical Messenger, Centricity Patient Portal, Centricity Clinical Gateway or Qvera Interface Engine; Used for demonstration: Micromedex CareNotes Patient Education Resources, Micromedex Clinical Knowledge Suite). The certification includes all required certification criteria, plus Accounting of Disclosures and SOAP protocols for Transition of Care.

Pricing Transparency for Complete EHRs

• There may be one-time costs to support installation and implementation of certified capabilities for all measures.
• There may be annual support and/or maintenance costs associated with certified capabilities for all measures.
• There may be one-time interface configuration costs associated with the following measures: Demographics (170.314.a.3), Image Results (170.314.a.12); Transitions of Care / referral summaries (170.314.b.1-2); Incorporate Laboratory Tests and Values/Results (170.314.b.5); Clinical Quality Measures (170.314.c.1-3); Transmission to Immunization Registries and Public Health Agencies - Syndromic Surveillance (170.314.f.2-3); Transmission to Cancer Registries (170.314.f.5-6); Automated Measure Calculation (170.314.g.2); and Report Specific Cases to Specialized Registry.
• There may be annual or monthly subscription costs through third-party partners associated with the following measures: Clinical Decision Support (170.314.a.8) and Patient-Specific Education Resources (170.314.a.15).
• There may be a one-time configuration cost for reporting on all measures.
• There may be additional costs for state or local transmission methods for public health measures.
• Customers may choose to incur additional one-time costs to customize clinical content.
• Customers may choose to incur additional transmission costs associated with the following measures: Transitions of Care / referral summaries (170.314.b.1-2)
New features and enhancements detailed in this guide impact the clinical side of Centricity Practice Solution and fulfill CCHIT 2014 certified Ambulatory EHR requirements; many new and existing features support Meaningful Use reporting. The guide is organized by Meaningful Use measure so you can easily review how Meaningful Use requirements are supported by changes in this release.

You are responsible for understanding and meeting the requirements of achieving meaningful use through use of HHS certified EHR technology and associated standards.

You are responsible for understanding applicable GE documentation regarding Meaningful Use functionality and reporting specifications, and for using that information to confirm the accuracy of meaningful use attestation and ensure the correct data is captured.

You are responsible for ensuring an accurate attestation is made.

Moving beyond compliance, Centricity Practice Solution continues with enhanced user interface and streamlined navigation, including integration of Administration and Chart modules for enhanced performance and new left module navigation and ribbon style main menus.

How do I learn to use Centricity Practice Solution?

To learn about new features included in this release, read this document from cover to cover. Additional resources and detailed user instructions are available in online help and Adobe PDF guide format for users at all levels, including system administrators, clinicians and staff, clinical content developers, and clinic managers.

For features included in previous Centricity Practice Solution releases, see What’s New in Centricity Practice Solution 11x, 10x, and 9x.

For detailed information about how Meaningful Use data is collected and reported, see Achieving Meaningful Use with Centricity Practice Solution. This guide offers guidance on Meaningful Use Stage 1-2 functional measures and clinical quality measures reporting. It is available in an easy-to-use HTML help format and a PDF guide format.

Documentation library

The complete documentation library is available as a zipped archive from https://engage.gehealthcare.com/community/en/cps/documentation.

Unzip the file to a folder on your system and make sure that users who need access to library resources can access the network location of the folder.

If you open this guide from the Centricity Document Library or from a library folder copied to your network or a local machine, you can click links to other guides to open them. These links will not work if you copy a PDF to a location outside the library folder.
The following planning and implementation resources are available in this library:

- **System Planning and Requirements for Centricity Practice Solution**: This guide contains an overview of features that impact hardware/software decisions, interfaces, and system planning and maintenance information.
- **Configuring Environments for Centricity Practice Solution**: Detailed hardware and software requirements.
- **Installing Centricity Practice Solution**: This guide contains instructions to install and set up Centricity Practice Solution for the first time.
- **Upgrading to Centricity Practice Solution**: This guide contains instructions for upgrading an existing installation to Centricity Practice Solution.
- **Installing and Maintaining Centricity Clinical Gateway**: Refer to this manual to maintain legacy Centricity Clinical Gateway and Cloverleaf implementations.
- **Calculating hardware requirements for Centricity Practice Solution**: Use this Microsoft® Excel spreadsheet to fine-tune your hardware requirements. If you have 25 or more users, plan to use this tool. The spreadsheet is available in the same folder as this document. When you unpack the zip file, the path is /guides/calculating_hardware_requirements_cps.xls.
- **Managing interfaces with Centricity Practice Solution**: Includes resources to support import and export of clinical data and patient information to and from other systems, such as labs, transcription services, insurance companies, and other healthcare organizations.

---

**Service Portal for Healthcare IT & Performance Solutions**

Go to the Service Portal for Healthcare IT & Performance Solutions Web site, [https://engage.gehealthcare.com/community/en/cps/](https://engage.gehealthcare.com/community/en/cps/), for access to the following information resources:

- Product updates and service packs
- Integration products and support
- Latest versions of release notes and product documentation
- Product support and services information
- Clinical content and user forums
- Training resources

**Online help**

When you need a quick answer about using a particular feature in Centricity Practice Solution, online help is your fastest route. Wherever you are in the application, press F1 for relevant help about the task at hand:

- Find conceptual information in Concepts links and Glossary entries
- Follow step-by-step procedures to complete a task

The table of contents, index, search, and glossary can help you learn more about a feature or assist you in troubleshooting a problem or answering a question.

**New/Changed features (by Meaningful Use measure)**

In the following sections, you'll find detailed descriptions of new features implemented in support of Meaningful Use 2014 measures organized by measures. For information about features and changes that impact all measures, see “Global features support Meaningful Use 2014 edition reporting” on page 57, and other content following this section.
For more information about Meaningful Use Reports and reporting features, see the guide *Achieving Meaningful Use with Centricity Practice Solution* available in your Centricity Document Library.

This release includes a new Web-based reporting solution, Centricity Quality Reporting, that supports functional and quality measure reporting for Meaningful Use Stage 1 and Stage 2. For details, see “Report Functional Measures and Clinical Quality Measures (CQMs) to CMS” on page 54.

**If you upgrade in the middle of a reporting period...**

If you upgrade to this release in the middle of a Meaningful Use reporting period, prior to performing the upgrade, run all reports on Quality Reporting Services hosted by the Medical Quality Improvement Consortium (MQIC) or in Crystal Reports. After you complete the upgrade, run reports for the remainder of the reporting period in Centricity Clinical Quality Reporting (CQR). For attestation, combine the numerators and denominators from both reports to get the final numbers. For details, see the guide *Achieving Meaningful Use with Centricity Practice Solution* available in your Centricity Document Library.

**Core Measure 1: CPOE for Medication, Laboratory and Radiology Orders**

*Measure:* More than 60% of medication, 30% of laboratory, and 30% of radiology orders created by the EP during the EHR reporting period are recorded using CPOE.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stage 1: Use CPOE for medication orders directly entered by any licensed healthcare professional who can enter orders into the medical record per state, local and professional guidelines.</td>
<td>More than 30% of unique patients with at least one medication in their medication list seen by the EP have at least one medication order entered using CPOE.</td>
<td>More than 60% of medication, 30% of laboratory, and 30% of radiology orders created by the EP during the EHR reporting period are recorded using CPOE.</td>
</tr>
<tr>
<td>Stage 2: Adds laboratory and radiology orders.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following workflows have been added or enhanced to support this measure:

- Enter required Licensed Healthcare Professional user attributes
- Set new Laboratory and Radiology order category/code classifications
- Use Medication Administration HTML encounter form
- Use Medication Administration custom list
- Identify uncoded medication as drug or non-drug so uncoded item is included in calculation
- Select Pending Approval prescribing Method (for use with resident and provider)
- Optional HTML Care Plan section added to CPOE A&P-CCC form. See “CPOE A&P-CCC form” on page 71.
Core Measure 1: CPOE for Medication, Laboratory and Radiology Orders

Product records, stores, retrieves, manages medication, lab, and radiology orders

In Administration > Codes > Chart > Codes and Categories you can categorize an order as Laboratory, Radiology, or Other to classify orders for Meaningful Use.

On the Add/Change Category window, select a category and set to Laboratory, Radiology or Other. Default is Other.
All codes within a configured category will have the same classification.

Eligible Professional (User) attributes

In User setup, new Meaningful Use Attributes section on Chart Access tab lets you enter information about the eligible provider required for Meaningful Use.

Indicate user is an Eligible Professional (EP)
Set reporting stage and year and whether user has attested
Indicate user is Licensed Healthcare Professional (for CPOE)
Identify Uncoded Medication as drug or non-drug during prescription

When you add an uncoded medication, you can classify it as Drug or Non-Drug, so it can be included in the CPOE for Medications measure calculation. Only uncoded medications set as Drug are counted. This option is only available when you enter an uncoded medication.

A warning displays if you have not made this selection before saving the changes. If you do not select Drug or Non-Drug, the medication is saved as Unknown.

Select Pending Approval Prescribing Method

When a prescription must be approved by a supervising provider, for example, when a resident enters the prescription, you can now select Pending Approval prescribing method.

Recommended workflow: A resident documents the patient encounter, initiates a medication update or refill by filling in the Authorized Provider field with the attending provider’s name, and selects Pending Approval as the Prescribing Method. The resident then puts the document on hold, signs clinical list changes, and routes to the attending physician for review. The attending physician reviews resident notes plus the pending approval, and if they agree, the physician selects a final Prescribing Method and signs.

Administered Medications form

Administered medication are now clinical list items that follow the same rules of Signed, Filed in Error, and Discard for Medications. Clinical List locking also applies for these items. You access this functionality in an update when you open the Medication Administration form.
Similar to immunizations, a medication administration involves two entries: first a provider’s request to administer a particular drug and second to note the actual administration.

The medication administration and immunization forms display interactions during an update, but do not support interaction override. You can enter your override reason in the form comment section if you want. To capture this information in the chart, add the medication to the Medication list and enter the override and reason when the interaction alert displays.

To begin, click **New** on the Summary tab and fill out an administration request on the **Add/Update Request** tab.

Note that you must populate the Medication Administration Custom list before you can select a medication on this form.
All requests entered for the patient (active and past) appear on the **Administration Meds Summary** tab.

Enter or change administration details on the **Administer Medication** tab.

Details of Administration Request carry over into this tab.

Note: Interaction checking occurs now at the point of administration as well.

Fill in administration details.

Enter administration Start and Stop times when relevant.

Click **Commit Administration** to save entries.
Medication Administration Custom List

To use the Medication Administration encounter form, you must first set up and populate Administered Medication Custom Lists in Administration under Chart.

1. Click New and name a new custom list.

2. Click Add New Medication to access Find Medication window and select a medication. Edit window opens automatically.

3. Add relevant details and click OK.
Core Measure 2: ePrescribing (eRx)

**Measure**: More than 50% of all permissible prescriptions written by the EP are compared to at least one drug formulary and transmitted electronically using Certified EHR Technology.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate and transmit permissible prescriptions electronically (eRx).</td>
<td><strong>More than 40% of all permissible prescriptions written by the EP are transmitted electronically using certified EHR technology.</strong></td>
<td><strong>More than 50% of all permissible prescriptions written by the EP are compared to at least one drug formulary and transmitted electronically using Certified EHR Technology.</strong></td>
</tr>
</tbody>
</table>

All requirements for Stages 1 and 2 are met by Centricity Advanced ePrescribing. All electronically transmitted prescriptions meet federal content exchange standards and implementation specifications for exchanging electronic health information.

RxNorm nomenclature standards for representing clinical drugs are implemented with Centricity Advanced ePrescribing. You can transmit prescription with RxNorm medication code if known according to the standard NCPDP Script 10.6 content exchange standard.

**New review/confirm screen for electronic prescriptions**

When ePrescribing is enabled and the Electronic prescribing method is selected for a pharmacy, you must review and confirm new or refilled prescriptions before you can sign and send them.

This screen displays automatically when you sign/send an electronic prescription. Select the prescription to review. Click Complete Review to mark as Reviewed.

Change Pharmacy if necessary.

All medications must be reviewed before you can continue.
Core Measure 3: Record Demographics

Measure: More than 80 percent of all unique patients seen by the EP have demographics recorded as structured data. (includes preferred language, sex, race, ethnicity, date of birth)

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record the following demographics: preferred language, sex, race, ethnicity, date of birth.</td>
<td>More than 50% of all unique patients seen by the EP have demographics recorded as structured data.</td>
<td>More than 80 percent of all unique patients seen by the EP have demographics recorded as structured data.</td>
</tr>
</tbody>
</table>

In this release patient demographics are updated to record preferred language, race, ethnicity as structured data and meet new standard coding requirements. The following workflows are included:

- **Record allowed exclusions:** (1) patient declines to specify race or ethnicity or preferred language and (2) recording is prohibited by the state (for race and ethnicity only).
- **Select one preferred language, one ethnicity value, and up to two race values for a patient.**
- **Define and manage non-standard/custom race and ethnicity values as subcategories.** Map these subcategories to standard race and ethnicity values. For example, you might record Chinese and Asian-Indian as sub-categories to the required standard of Asian. These subcategories can be recorded on patient records and they will meet a required standard (Asian) and therefore, count for this measure.
- **ISO 639-2 Alpha-3 language codes constrained to codes present in ISO 639-2 Alpha 2 code set.**
- **Other LinkLogic demographics changes:**
  - LinkLogic supports import and export of patient cell phone and other phone values.
  - LinkLogic supports patient preferred contact method in PID-40.
  - Import/export full 20 characters of patient MRN.
  - LinkLogic handles non-standard PID-10 Race and PID-16 Marital Status values on import and export.
  - LinkLogic supports import/export of Primary Care Provider (PCP) value in PD1 segment.
  - LinkLogic supports import/export of Emergency Contact in NK1-3 Relationship field with value “T”.

**Mapping race and ethnicity**

Your previous race and ethnicity values are carried over just as entered in Registration, but will be mapped to new standard values for the purposes of measure calculation.

Previous Other, Undetermined, or User defined values are also brought over unchanged and mapped to Unspecified in this release. You can change these records to a required value that will be counted if desired. New required values are **bold**.
### Race mappings

<table>
<thead>
<tr>
<th>This value...</th>
<th>Maps to this required value...</th>
<th>This sub-category...</th>
<th>Maps to this required value...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asian</td>
<td>Asian</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Caucasian</td>
<td>White</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Black or African American</td>
<td>Black or African American</td>
<td></td>
<td></td>
</tr>
<tr>
<td>American Indian or Alaska Native</td>
<td>American Indian or Alaska Native</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other</td>
<td>None</td>
<td>Other</td>
<td>Unspecified</td>
</tr>
<tr>
<td>Undetermined</td>
<td>None</td>
<td>Undetermined</td>
<td>Unspecified</td>
</tr>
<tr>
<td>Chinese</td>
<td>None</td>
<td>Chinese</td>
<td>Asian</td>
</tr>
<tr>
<td>Filipino</td>
<td>None</td>
<td>Filipino</td>
<td>Asian</td>
</tr>
<tr>
<td>Japanese</td>
<td>None</td>
<td>Japanese</td>
<td>Asian</td>
</tr>
<tr>
<td>Native Hawaiian</td>
<td>Native Hawaiian or Pacific Islander</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multiracial</td>
<td>None</td>
<td>Multiracial</td>
<td>Unspecified</td>
</tr>
<tr>
<td>Pacific Islander</td>
<td>Native Hawaiian or Pacific Islander</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User defined</td>
<td>None</td>
<td>From your previous implementation</td>
<td>Unspecified</td>
</tr>
</tbody>
</table>

### Ethnicity mappings

<table>
<thead>
<tr>
<th>This value...</th>
<th>Maps to this required value...</th>
<th>This sub-category...</th>
<th>Maps to this required value...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hispanic or Latino</td>
<td>Hispanic or Latino</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Not Hispanic or Latino</td>
<td>Not Hispanic or Latino</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other or Undetermined</td>
<td>None</td>
<td>Other or Undetermined</td>
<td>Unspecified</td>
</tr>
<tr>
<td>Patient Declined</td>
<td></td>
<td>State Prohibited</td>
<td>Unspecified</td>
</tr>
<tr>
<td>User defined</td>
<td>None</td>
<td>From your previous implementation</td>
<td>Unspecified</td>
</tr>
</tbody>
</table>

### Language mappings

All previous languages are carried forward and if possible are mapped to the ISO 639 languages. You will get credit as long as a *Preferred Language* is specified for the patient.
Configuring Race and Ethnicity in Administration

Race and Ethnicity values cannot be removed or altered in Administration, but you can create Race or Ethnicity sub-categories and map them to a standard race category. Sub-categories appear in Registration directly under the standard race category to which they are mapped and appear in the order listed in Administration.

Other demographics changes and LinkLogic

- **LinkLogic supports import and export of patient cell phone and other phone values.** LinkLogic now imports and exports up to three phone numbers, including cell phone. LinkLogic now supports the HL7 XTN extended phone number data type for PID-13. LinkLogic Import also stores the phone type identifier which supports mapping for user-defined phone types. LinkLogic reads values for home phone and cell phone in PID-13 and only the work phone number from PID-14.1, where PID-14.3 component is either not specified or is PH. All other phone values from PID-14 are ignored. LinkLogic exports the patient’s three phone numbers if present in Registration as multiple repeating items in PID-13. The phone number value is sent in the first component of each item and the phone type is sent in the third component of each item.

- **LinkLogic supports patient preferred contact method in PID-40.** Patient contact method is now exchanged in the non-standard field PID-40 Patient Preferred Contact Method. LinkLogic imports and exports a 1-character value for patient preferred contact method in the optional field PID-40 at the end of the PID segment in ADT and BAR messages. To send or receive patient contact method using this field you must associate the optional Add-On IXP file pid40contactby.ixp with the LinkLogic interface. This IXP file maps the HL7 values to CPS values to store to or export from the database in the PatientProfile.ContactByMId field. For detailed information about using IXP files, see “Using.ixp configuration files” in Managing Interfaces with Centricity Practice Solution.

- **LinkLogic handles non-standard PID-10 Race and PID-16 Marital Status values on import and export.** Previously export mapping for Race and Marital Status was limited to HL7 standard single character values. Now both values can be up to 250 characters.

- **LinkLogic supports import/export of Primary Care Provider (PCP) value in PD1 segment.** DemographicsLink interface specification includes PD1 (Patient Additional Demographic) segment, and uses the PD1-4 field to import and export a primary care physician, if specified.

- **LinkLogic supports import/export of Emergency Contact in NK1-3 Relationship field with value “T”**. If the NK1-3 “T” value is not supported by another system, use LinkLogic cross-reference file to map this to a different value.
Core Measure 4: Record Vital Signs

Measure: More than 80 percent of all unique patients seen by the EP have blood pressure (for patients age 3 and over only) and/or height and weight (for all ages) recorded as structured data.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Stage 1</strong>: Record and chart changes in vital signs: Height, Weight, Blood pressure. Calculate and display BMI. Plot and display growth charts for children 2-20 years, including BMI.</td>
<td>For more than 50% of all unique patients age 2 and over seen by the EP, blood pressure, height and weight are recorded as structured data.</td>
<td>More than 80% of all unique patients seen by the EP have blood pressure (for patients age 3 and over only) and height and weight (for all ages) recorded as structured data.</td>
</tr>
</tbody>
</table>

Changed in Stage 2: Record Blood pressure (age 3 and over). Plot and display growth charts for patients 0-20 years.

Only calculation requirements have changed for this measure. Changes in the release include:

- Reporting services now calculate to Stage 1 and Stage 2 requirements.
- New CCC-Basic Vital Signs encounter form updated to ensure accurate reporting.

Core Measure 5: Record Smoking Status

Measure: More than 80 percent of all unique patients 13 years old or older seen by the EP have smoking status recorded as structured data.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record smoking status for patients 13 years old or older.</td>
<td>More than 50% of all unique patients 13 years old or older seen by the EP have smoking status recorded as structured data.</td>
<td>More than 80% of all unique patients 13 years old or older seen by the EP have smoking status recorded as structured data.</td>
</tr>
</tbody>
</table>

Only calculation requirements have changed for this measure. Changes in the release include:

- Reporting services now calculate to Stage 1 and Stage 2 requirements.
- Smoking Status in CCC-Basics encounter forms updated to meet new smoking status types standard coded in SNOMED CT.

- CPOE A&P-CCC
- FH-SH-CCC (Family History / Social History)
- Risk Factors-CCC
- Hypertension Q&E-CCC

- Current every day smoker
- Current some day smoker
- Former smoker
- Never smoker
- Smoker, current status unknown
- Unknown if ever smoked
- Heavy tobacco smoker
- Light tobacco smoker
Expanded Smoking Status feature in CCC-Basic forms

Smoking status sections in CCC-Basic forms were updated to include expanded smoking types required for Meaningful Use Stage 2. The following image shows an example of the Family History Social history form.

When you choose Current Smoker, now also select from new Status type list.

Click Ref to see expanded Reference content.
The Risk Factors-CCC form has also been expanded to meet new requirements and provides additional details, such as previous smoker status and passive smoke experience, types of tobacco used, including smokeless tobacco.

Core Measure 6: Clinical Decision Support

**Measure:** Use clinical decision support to improve performance on high-priority health conditions.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stage 1: Implement one clinical decision support rule relevant to specialty or high clinical priority with ability to track compliance.</td>
<td>Implement one clinical decision support rule.</td>
<td>Implement 5 clinical decision support interventions related to 4 or more clinical quality measures during reporting period.</td>
</tr>
<tr>
<td>Stage 2: Use clinical decision support to improve performance on high priority health conditions.</td>
<td></td>
<td>Have enabled drug-drug and drug-allergy interaction checks for reporting period. (previously Core 2).</td>
</tr>
</tbody>
</table>

In Stage 2, providers continue to have considerable flexibility in meeting this measure. They need only attest they are using clinical decision support interventions. The application already includes many implemented interventions in the encounter forms. Anything that provides a clinically relevant notification qualifies, including pop-up alerts that requires a response or an indicator on a form.

While drug-drug or drug-allergy interaction checks can no longer qualify as one of the five interventions, Drug-Age, Drug-Disease, and Drug-Gender checking do qualify.

In addition to existing CDS interventions in the application and encounter forms, this release provides the following features related to this measure:

- **Enhanced source-cited clinical reference resources** at the point of care.
- **Secured, audited access** to CDS interventions and information.
Core Measure 6: Clinical Decision Support

- HL7-standard contextual Web-based clinical reference resources for problems, medications, and lab results (flowsheet).
- Expanded support for allergies and drug interaction checking based on Medi-Span.

**Enhanced clinical decision support and full references**

New CCC Basic package include forms relevant to clinical quality measures that provide CDS interventions.

For this release CCC Basic forms included with the application have been updated to include enhanced CDS interventions and full references. For detailed information about CDS prompts and their configuration, see the CCC Basic release notes.

If you license the separate full CCC forms package, relevant forms will be updated for Meaningful Use 2014 in the next full update in CCC v9. However, CCC Basic can be implemented with CCC v8.3.8.

For example, the following forms, provide numerous prompts and include enhanced references: CPOE A&P-CCC, Hypertension Q&E-CCC, Vital Signs-CCC, and Test Management-CCC. Here’s an example from the A&P form:

The Clinical Decision Support (CDS) included in the CCC Basic package triggers automatic alerts in the CPOE A&P-CCC form and triggers alerts in the Hypertension Q&E form. Click **View Therapeutic Recommendations** to view the alerts. Click ? in the forms to view detailed information about the criteria used for CDS recommendations.

**CPOE A&P-CCC form CDS prompts** display based on the problem selected from the Assessment list.Prompts display for the following problems:

- Diabetes Mellitus (ICD-250)
- Myocardial Infarction, Acute (ICD-410)
- Prenatal Care, delayed (ICD-V23.7)
CHF (ICD-428.0)
- ASA Prophylaxis (ICD-410, ICD-250)
- Hypercholesterolemia (ICD-272.0)
- Screening PSA (ICD-V76.44)

**Hypertension Q&E-CCC form CDS prompts** display are shown when the user clicks View Recommendations and View secondary causes of HTN.

You can use a text editor to edit form configuration files, including CDS prompts.

---

**Clinical Decision Support and Clinical Reference access secured by permissions**

A new permission Chart > Access Clinical Decision Support secures access to interventions displaying in the application and forms and to Web-based content accessed from the Clinical Reference button. This permission is granted on install/upgrade by default to users with View/Change Chart permissions, but may be changed. All accesses are audited and entries are timestamped.

See online help for more information about changing permissions. Users who do not have the permission see the following alert:

**Important.** Currently, Clinical Decision Support in encounter forms such as CPOE A&P-CCC or Hypertension Q&E-CCC requires an additional permission configuration. These forms check whether the provider is a member of the “CDS Access” security group. To ensure all providers granted the ACCESS Clinical Decision Support permission can see CDS content in forms, you must create a security group named “CDS Access” and add all clinical users to that group.

**View HL7 standard Clinical Reference content for problems, medications, lab results**

New HL7 standard compliant Web-resources automatically display context-appropriate, clinical information formatted for clinical users that can be printed from patient medications, problems, flowsheet.

Select a clinical list value and then click the Clinical Reference button to launch context-specific content on the Web-based service configured for your organization.

The service displays a Web page with one or more relevant resource links to select from. Depending on your service, you may also choose an appropriate language.
Set up Clinical Reference Web site

GE currently supports Truven Health Analytics Web content that meets the HL7 context-aware knowledge retrieval standard. Other providers that meet this standard will also be supported. Unlike general capability clinical reference sites available from the legacy Web Lookup icon, only a single source provider for HL7 context-aware content can be licensed for a site.

To set up the Clinical Reference Web site, go to Administration > Chart > Internet Sites, click New and then select Clinical Reference. Enter the name, URL and Keyword(s) used for counting accesses for Meaningful Use given to you by your content provider. Truven URL and keywords are installed by default.

Expanded support for allergies and drug interaction checking

Stage 1 requirement for drug-drug and drug-allergy interaction checks is now part of this Stage 2 core measure. Interaction checks are now performed based on Medi-Span database installed with the application. The Medi-Span database expires monthly and must be updated regularly using monthly clinical content knowledgebase updates. The application will warn you when the database is about to expire and when it has expired.

New interaction alert icon

Interaction-checking accesses the Medi-Span database in real time. When an error or temporary delay occurs during drug interaction calculation due to network issues or a problem with the Medi-Span database, a red no data icon displays on the application interface. Mouse over the icon for more information about the current data problem.
Core Measure 7: Patient Electronic Access

**Measure:** Provide patients the ability to view online, download and transmit their health information within four business days of the information being available to the EP.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Stage 1:</strong> Provide patients with electronic copy of their health information upon request (Core 12). Provide timely electronic access within 4 business days of information being available to the EP (Menu 5).</td>
<td>More than 50 percent of all patients who request an electronic copy of their health information are provided it <em>within 3 business days</em> (Core 12). At least 10 percent of unique patients seen by the EP are provided timely electronic access to their health information (within four business days (Menu 5).</td>
<td>Measure 1: More than 50 percent of unique patients seen by the EP provided timely online access to their health information (within 4 business days after the information is available to the EP). Measure 2: More than 5 percent of unique patients seen by the EP view, download, or transmit to a third party their health information.</td>
</tr>
<tr>
<td><strong>Stage 2:</strong> Provide patients the ability to view online, download and transmit their health information within four business days of information being available to the EP.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This measure has changed to focus on online access to information. The application provides the following new user workflows to support this measure:

- Patients can view, download, and transmit their chart information from a certified Patient Portal.
- Patient access to charts on the portal triggers an entry in the Meaningful Use Activity Log and counts towards the measure.

**View, download, or transmit health information from a certified Patient Portal**

In this sample from Centricity Patient Portal, the patient can view their chart and send (Transmit) a copy via secure messaging.
Core Measure 8: Clinical Summaries

Measure: Clinical summaries provided to patients within one business day for more than 50% of office visits.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provide clinical summaries for patients seen by the provider for an office visit.</td>
<td>Provided to patients for more than 50% of visits, within 3 business days in any form.</td>
<td>Must provide within one business day and offer at least one electronic format option.</td>
</tr>
</tbody>
</table>

In this release, a qualifying office visit is based on values from Office Visit value sets. Previously this was determined by the presence of a document type with a name starting with “Office”.

Office Visit value sets includes document types and orders (CPT Codes and SNOMED codes) associated with a visit. If you have custom codes associated with visits, they can also be mapped to the appropriate value set. See “Mapping data for Meaningful Use” on page 60.

On upgrade, all qualifying document types included in Patient Encounter (MU) document view are mapped to the Office Visit value set. This view is still included in the application but is Deprecated.

In the previous release, only printing/faxing handouts Patient Instruction (CCC) or Clinical Visit Summary (GE) for qualifying office visits, or exporting a generated CCD Chart Summary was counted. In this release, use of handouts is not counted. Instead, printing, saving to file, or electronically sending a generated Clinical Summary CCDA document is logged and counted. These events are logged in the Patient MU Activity Log which is used for calculating the numerator for the measure. See “Global features support Meaningful Use 2014 edition reporting” on page 57, for details.

The application provides the following new user workflows to support this measure:

- **Generate a standard CCDA format Clinical Summary** based on an update or signed document related to an office visit.
- **Customize a clinical summary** to exclude certain data if deemed appropriate.
- **Include and count CVS Declined (PTDECLINECVS) observation** if patient declines a summary. Check CVS Declined in the Patient Instructions-CCC form and the MU Core Checklist form.
- **Send using Centricity Clinical Messaging (Kryptiq).**
- **Send to a configured Patient Portal (available v12.1).**

Generating a clinical visit summary

There are several ways to create a clinical visit summary:

- **During an update**, in an In Progress document, select More > Create Clinical Visit Summary.
In the Documents list, select a signed document and right-click to select Create Clinical Visit Summary.

In encounter forms, click the Clinical Visit Summary button. This feature is available in the Patient Instructions-CCC form and the MU Core Checklist form.

Custom encounter forms - To access in a custom form, use the MEL symbol MEL_GEN_CVS. See also "New and changed MEL data symbols" on page 69.

**Reviewing and customizing the Clinical Visit Summary**

When you create a clinical visit summary, a summary based on the selected document appears in a preview screen in CCDA format. Select links in the Table of Contents to review content in the document. Click Customize to select sections or values to exclude.

To save and deliver the visit summary, click—

- **Save to File** to store to portable media.
- **Print** and give to the patient.
- **Save to Chart and Close** to save to the chart and send later via Centricity Clinical Messaging

Save to File and Print actions also save the summary to the chart.

Select link to jump to a section and review. Click Customize to select sections or values to exclude.
Customizing the Clinical Visit Summary

You can select sections of the document to exclude. A note appears in that section that the information is unavailable. You can also exclude individual clinical items under Laboratory Results, Problems, Medications, and Procedures. When you save the visit summary, the preview screen refreshes and you can check your changes.

A visit summary appears beneath its parent document in the Document list like an appended document, however the visit summary can be sent separately. The document type is Clinical Visit Summary.

Reprinting/updating the summary

If you print the summary and later wish to send an electronic version, you must regenerate it. If there have been no changes, the new summary will be identical. You can also update the summary to reflect recent changes by regenerating it. Clinical items retrieved for the summary are always current and active.

Required permissions

Users must have existing permissions Chart > Export Summary Documents and Chart > Export Unsigned Observations to generate and send clinical visit summaries.

The existing Chart > Export Chart Summary permission is renamed Chart > Export Summary Documents. This permission is also required to generate and send Transition of Care documents. See "Core Measure 15: Summary of Care (Transition of Care)" on page 34. On upgrade, user permission assignments are maintained.
Core Measure 9: Protect Electronic Health Information

Measure: Conduct or review a security risk analysis in accordance with the requirements under 45 CFR 164.308 (a)(1), including addressing the encryption/security of data at rest and implement security updates as necessary and correct identified security deficiencies as part of its risk management process.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protect electronic health information created or maintained by the certified EHR technology through the implementation of appropriate technical capabilities.</td>
<td>Conduct or review a security risk analysis per 45 CFR 164.308 (a)(1) and implement security updates as necessary and correct identified security deficiencies as part of its risk management process.</td>
<td>Conduct or review a security risk analysis in accordance with the requirements under 45 CFR 164.308 (a)(1), including addressing the encryption/security of data at rest and implement security updates as necessary and correct identified security deficiencies as part of its risk management process.</td>
</tr>
</tbody>
</table>

Security risk analysis required for Meaningful Use is the same as that required by the HIPAA Security Rule. More information on the HIPAA Security Rule can be found using the following URL: http://www.hhs.gov/ocr/privacy/hipaa/administrative/securityrule/.

Following features support security requirements required for EHR certification for Stage 2 (45 CFR 170.314(d)(Privacy and Security)):

- **Tamper resistance:** Audit log alterations are detected and logged. Audit log cannot be disabled.
- **Audit event logging meets ATNA and ASTM data standards.** The application tracks events based on:
  - **Default logging status:** enabled/disabled where allowed
  - **Classification by data type:** demographics, clinical, electronic prescribing, documents
  - **All required action codes:** additions, deletions, changes, queries, printing
- **Audit event reports now includes the capability to display original data state** for audit event types of change or modify represented with strike through text. Only changes to clinical list items like Problems, Medications, Allergies and Directives are tracked and represented in this manner. This capability requires contribution logging to be enabled and configured.
- **New preference to permit error logging on a local machine.**

**Set preference to permit error logging to a local machine**

Error logging is disabled by default. This means the application no longer stores data on workstation that the end user does not invoke, so the application is excluded from the encryption/security of data at rest requirement. However you can set a preference to log errors to a local machine for debugging purposes.

In Administration, go to System > User and Resource Management > Users > Preferences > User Preferences > System > Application. Under Error Logging, check Write error information to files on local workstation.
Important. Generated files can contain Protected Health Information for a patient (PHI). You are responsible for ensuring that PHI is protected according to HIPAA and other federal/state guidelines.

Core Measure 10: Clinical Lab-Test Results

**Measure:** More than 55% of all clinical lab tests results ordered by the EP during the EHR reporting period whose results are either in a positive/negative or numerical format are incorporated in Certified EHR Technology as structured data.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incorporate clinical lab test results into certified EHR technology as structured data.</td>
<td><strong>More than 40%</strong> of all clinical lab tests results ordered by the EP during the EHR reporting period whose results are either in a positive/negative or numerical format are incorporated in certified EHR technology as structured data.</td>
<td><strong>More than 55%</strong> of all clinical lab tests results ordered by the EP during the EHR reporting period whose results are either in a positive/negative or numerical format are incorporated in Certified EHR Technology as structured data.</td>
</tr>
</tbody>
</table>

Only calculation requirements have changed for this measure. Changes in the release include:

- Reporting services now calculate to Stage 1 and Stage 2 requirements.
- CCC-Basic encounter forms updated to ensure accurate reporting and to provide full reference resources.

Qvera provides a Lab Import interface for use with a laboratory that sends in HL7 2.5 format

See also “Core Measure 1: CPOE for Medication, Laboratory and Radiology Orders” on page 4.
Core Measure 11: Patient Lists

**Measure:** Generate at least one report listing patients of the EP with a specific condition.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate lists of patients by specific conditions to use for quality improvement, reduction of disparities, research or outreach.</td>
<td>Generate at least one report listing patients of the EP with a specific condition.</td>
<td>No change.</td>
</tr>
</tbody>
</table>

The application includes the ability to generate patient lists using the Inquiries module based on a full range of patient and clinical variables, including problems, medications, medication allergies, demographics, laboratory tests and values/results, patient communication preferences.

There is no change between Stage 1 and Stage 2 for this measure, however the inquiries module has been enhanced to allow its use in fulfilling other Meaningful Use measures. See “Send reminders from the Inquiries module” on page 27, and “Data Portability - exporting patient charts from Inquiries module” on page 62.

Core Measure 12: Preventive Care (Patient Reminders)

**Measure:** More than 10 percent of unique patients who had 2 or more office visits with the EP within the 24 months before the beginning of the reporting period were sent a reminder, per patient preference when available.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stage 1: Send reminders to patients per patient preference for preventive/ follow up care.</td>
<td>More than 20% of all unique patients 65 years or older or 5 years old or younger were sent an appropriate reminder during the EHR reporting period.</td>
<td>More than 10 percent of all unique patients who have had 2+ office visits with EP within 24 months prior to reporting period were sent a reminder per patient preference. Now required Core measure - previously Menu and optional.</td>
</tr>
</tbody>
</table>

| Stage 2: Use clinically relevant information to identify patients who should receive reminders for preventive/follow-up care and send these patients reminders per patient preference. | |

Previously, only reminders for children 5 or younger and elders 65 or older were considered for this optional Menu measure. Now all patients who have seen the EP at least twice within the past 24 months are considered, and the reminder must be based on clinically relevant information stored in the application. Previously simply reminding the patient of a scheduled test counted; now reminders must require patient action to qualify, for example, a reminder to call and schedule a required test or take an action to prepare for a test.

!!! **Important:** Before using this feature, store reminder letter templates in a root-level Letters folder with “Actionable” in the folder name. When letters are sent using these templates they are automatically counted for Meaningful Use.
The application provides the following new features that support your ability to send reminders to a list of patients:

- **Enhanced support in Inquiries** - Ability to sort by date and time based on problems, medications, medication allergies, demographics, laboratory tests and values or results, patient communication preferences.

- **Send reminders directly from the Inquiries module.** Select Send Reminder option to configure a printed reminder to send to a list of patients (Sending by secure messaging or to a patient portal available in v12.1).

- **New permission: Clinical Inquiries/Reports > Print reminders for patients.** Lets you print the letter template for a reminder to mail to a patient. This permission is enabled for all users by default.

- **Added Secure Messaging to patient contact method options in Registration.** (On upgrade not added if you have already created a custom value.)

- **New data symbol PATIENT.CONTACTBY returns the value in the patient’s registration record Contact By field.**

**Send reminders from the Inquiries module**

Before using this feature, store reminder letter templates in a root level Letters folder with “Actionable” in the folder name. When letters are sent using these templates they are automatically counted for Meaningful Use.

After configuring and running an inquiry to identify a list of patient, select **Send Reminder** in the Activity list to set up and print a reminder letter for each patient.
Core Measure 13: Patient-Specific Education Resources

Measure: More than 10% of all unique patients seen by the EP are provided patient-specific education resources identified by Certified EHR Technology.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use clinically relevant information from Certified EHR Technology to identify patient specific education resources and provide those resources to the patient.</td>
<td>More than 10% of all unique patients seen by the EP are provided patient-specific education resources.</td>
<td>Percentage unchanged, but patient-specific education resources must be identified by Certified EHR Technology. This means the application must electronically identify patient relevant clinical information and deliver it using a standards-based mechanism.</td>
</tr>
</tbody>
</table>

In the previous release, only medication handouts for a prescribed medication generated from Print Handout on prescription window were counted to meet this requirement. In this release, any context-aware (HL7 Infobutton standard) handout for a medication, problem, or lab result (flowsheet observation value) is counted.

The application provides the following new user workflows to support this measure:

- **Generate and print Web-based patient-formatted information** for problems, medications, lab results.
- **Configure Patient Education Web resources** in Administration > Internet Sites. Currently only one source can be licensed for whole site.

**Generate and print patient information from medications, problems, and flowsheet**

New HL7 standard-compliant Web resources automatically display context-appropriate, clinical information formatted for patients that can be printed from patient medications, problems, flowsheet.

Select a clinical list value and then click the Patient Education button to launch context-specific content on the Web-based service configured for your organization.

The service displays a Web page with one or more relevant resource links provider can select from. Depending on your service, you may also choose an appropriate language.
Core Measure 13: Patient-Specific Education Resources

These patient-context relevant clinical notes appear when you click the patient education button within the application. When the handout displays, you must **Print** the handout to get credit for Meaningful Use.
Set up Patient Education Web site

GE currently supports Truven Health Analytics Web content that meets the HL7 context-aware knowledge retrieval standard. Other providers that meet this standard will also be supported. Unlike general capability clinical reference sites available from the legacy Web Lookup icon, only a single source provider for HL7 context-aware content can be licensed for a site.

To set up the Patient Education Web site, go to Administration> Chart > Internet Sites, click New and then select Patient Education. Enter the name, URL, and Keyword(s) used for counting accesses for Meaningful Use given to you by your content provider. Truven URL and keywords are installed by default.
Core Measure 14: Medication Reconciliation

Measure: In over 50% of patient transitions of care medication reconciliation is performed electronically.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The EP who receives a patient from another setting of care or provider of care or believes an encounter is relevant should perform medication reconciliation.</td>
<td>The EP performs medication reconciliation for more than 50% of transitions of care in which the patient is transitioned into the care of the EP.</td>
<td>Moved from Menu to Core; percentage remains the same.</td>
</tr>
</tbody>
</table>

In the previous release, transitions of care that included medication reconciliation were counted if the CARETRANSIN (indicates transition of care document) and various medications reviewed and medications reconciled observations were present in the chart document. In this release, the calculation is the same, however, you can indicate that a document is a transition of care when you start or end an update. Medications reviewed/reconciled is automatically noted when you complete the reconciliation in the new Clinical Reconciliation form or check Medications Reviewed (when no electronic CCDA document has been received but a transition of care has occurred).

The application provides the following new user workflows to support this measure:

- **Mark a chart document as related to Transition of Care** when you start or end the update.
- **Review documents to be reconciled** when you start a chart update for a patient by opening the Clinical Reconciliation form.
- **Use HTML Clinical Reconciliation encounter form** to reconcile electronically medications, allergies, and problems. You have the ability to see and compare values from two or more sources and to merge them into the appropriate clinical list.

**Review documents to be reconciled in the Clinical Reconciliation HTML encounter form**

The Clinical Reconciliation form is included in the new CCC-Basic clinical kit included in this release. (See “New/Changed Clinical Content” on page 71, for details.) This form is accessible from the following forms: CPOE A&P-CCC, HPI-CCC, Problems-CCC, and MU Core Checklist-CCC.

A provider may also see imported CCDA documents for a patient on their Chart Desktop, or note their presence in the patient’s Document list when viewing the chart. To reconcile the content, you must view them in the Clinical Reconciliation form.
When you start an update for a patient, you can view documents to be reconciled by clicking the **Reconciliation** button in any of the previously described forms. In the form select **Documents to Reconcile** at the top left in the form to view all documents received.

Documents to be reconciled appear in this list. Check one or more items to add and click **Add to List**. Select list item and click **Edit** to modify details or **Remove** to remove from the list.

After all data is reconciled, click **Mark Reviewed** to complete reconciliation and remove the document from the list.
Mark an encounter as a Transition of Care at start or end of update

If you know a visit is a transition of care, you can mark it when you start the update. But you may not know initially. For example, during a visit a patient may report a visit with another provider and show you new medications they received. In that case, to get credit for Meaningful Use, manually add the medication and check Meds Reviewed. Then check Encounter is Transition of Care on the End Update window.

A new patient’s first visit (their first seen by encounter with a provider) automatically counts as a transition of care. Even if Encounter is Transition of Care is not checked, the first visit is included in the denominator.

New and changed MEL symbols for Clinical Reconciliation

The following new symbols support clinical reconciliation: DOCUMENTTORECONCILE and GET_RECONCILE_DOC_LIST can be used to display in a custom encounter form information about the external documents need to be reconciled. See also “New and changed MEL data symbols” on page 69.
Core Measure 15: Summary of Care (Transition of Care)

Provide a summary of care record for more than 50% of transitions of care and referrals, 10% or which are submitted electronically from the EHR.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The EP who transitions their patient to another setting of care or provider of care or refers their patient to another provider of care should provide summary of care record for each transition of care or referral.</td>
<td>Provide a summary of care record for more than 50% of transitions of care and referrals.</td>
<td>Provide a summary of care for more than 50% of transitions of care and referrals. Provide 10% of transitions of care and referrals electronically via certified EHR technology or to a provider receiving via a Nationwide Health Information Network Exchange or other ONC-validated exchange. Conduct one or more successful electronic exchanges of a summary of care with a recipient using a different EHR.</td>
</tr>
</tbody>
</table>

In the previous release, transitions of care were counted if the CARETRANSOUT observation was included in the chart document and a report or letter containing “Chart Summary” was either printed or faxed (audit events counted) or CCD chart summary was exported.

In this release, the calculation is based on an order document marked as Transition of Care, a Transition of Care CCDA document generated based on that document, signed by the referring/transferring provider, that is either printed or saved to file for transfer or sent electronically.

Electronic transmission will be handled by Centricity Clinical Messaging (Kryptiq) or Qvera Interface Engine (QIE) under the SOAP & XDR / XDM for Direct messaging standard. Whenever a transition of care document is sent directly using one of these electronic means it is logged and counted for Meaningful Use.

These events are logged in the MU Activity Log which is used for calculating the numerator for the measure. See “Global features support Meaningful Use 2014 edition reporting” on page 57, for details.

CMS states that transitions of care or referrals to another provider within the same EHR system are not counted towards Meaningful Use.

The application provides the following new user workflows to support this measure:

- **Administration**
  - Set referral and test order categories and order codes as Transition of Care. Referrals are set as Transition of Care by default.
  - Enter a secure electronic address (DIRECT) for Service Providers to receive transition of care documents. Kryptiq or QIE use this field to send TOC documents to intended recipients.
  - Orders — Mark an order as Transition of Care and generate and customize a CCDA format transition of care summary based on a signed In Process order.
  - Centricity Clinical Message (Kryptiq) — Send and receive Transition of Care message to or from a secure electronic address registered with a HISP using Kryptiq and SureScripts Network.
Core Measure 15: Summary of Care (Transition of Care)

- Qvera (QIE) — Send and receive Transition of Care message to or from a secure electronic address registered with a HISP or other authorized HIE electronic transmission protocol.

Stage 1 core measures 3-Maintain Problem List, 6-Maintain Medication List, and 6-Maintain Medication Allergies List are no longer included in Stage 2, but are reflected in this measure, because these sections of the chart must be included in the Transition of Care and other CCDA documents required for Meaningful Use.

Set order categories and codes as Transition of Care in Administration

Referral order categories are set as Transition of Care by default, so all referral order codes are automatically set and counted for Meaningful Use. Test order categories and codes may be set to be used as Transition of Care where including a CCDA transition of care document with the order is appropriate.

In Administration, go to Codes > Charts > Codes and Categories and select an order category and/or codes to modify.
Add secure electronic address for approved service providers

You can add a secure electronic address for external service providers associated with referral and test orders to send as Transition of Care.

In Administration, go to Codes > Charts > Service Providers and select a provider to modify.
Set a provider as an External Service Provider

By default, users are designated as Internal Service Providers. Providers within your system who might receive transitions of care or referrals from within or outside the system can be designated as an External Service Provider for the purpose of Meaningful Use. A transition of care sent to an internal provider is not counted for Meaningful Use, because it is assumed providers within the same system have shared access to the patient chart.

1. Go to Administration, and select Codes > Charts > Service Providers.
2. Click New. The Add Service Provider window opens.
3. Complete the fields for the new service provider and click Save & Continue.
4. The service providers listed in this file are set as External Service Providers.
Mark order as Transition of Care in Orders module and generate TOC document

When you configure a referral or test order in the Orders module, you can set the document containing the order to be a Transition of Care (TOC) document and then generate and optionally customize the CCDA document.

First, create an order and confirm that the order is set as **Transition of Care**. Set disposition to **Admin Hold** and sign the order.

Automatically checked for referral orders.

A referral reason is required.

Search for External Provider in the **Find Service Provider** window, search for Internal Provider in the **Find User** window.
When you are ready to process the order, return to the Orders module, select the order and click **Change**. On the Change Order screen click **Save & Create** to create the CCDA document.

When a transition of care CCDA document is saved it appears beneath its parent document in the Document list like an appended document, however the transition of care CCDA is sent separately. The document type is **Progress Exp: Transition of Care**.

### Customizing the Transition of Care CCDA

When you create a transition of care document, it is based on the selected order and the patient’s chart summary and appears in a preview screen in CCDA format. Select links in the **Table of Contents** to review content in the document. Click **Customize** to select sections or values to exclude.

To save and deliver the visit summary, click—

- **Save to File** to store to portable media.
- **Print** and give to the patient.
- **Save to Chart and Close** to save to the chart and send or deliver later.

**Save to File and Print actions also save the summary to the chart.**
You can select sections of the document to exclude. A note appears in that section that the information is unavailable. You can also exclude individual clinical items under Laboratory Results, Problems, Medications, and Procedures. When you save the transition of care document, the preview screen refreshes and you can check your changes.

Send and receive TOC documents

In this release, you can use Centricity Clinical Messaging (Kryptiq) or Overa Interface Engine (QIE) to send Transition of Care documents electronically to an external provider using a HISP. Work with your GE Sales representative Centricity Services technical consultant or Value-Added Reseller to plan and implement a configuration appropriate for your needs.
Sending TOC with Centricity Clinical Messaging...

After creating a TOC document in the patient chart, switch to the Desktop **Messaging** tab, and create a message from the sending provider to the external provider for the order. Open the patient chart (if necessary), then select and attach the TOC document and sign and send the message.

Sending TOC with Qvera Interface Engine (QIE)...

When this QIE interface is implemented, LinkLogic automatically creates an HL7 ORM message when the order is signed and places it in a folder where QIE can pick it up. Using QIE to transmit orders electronically, you do not need to manually generate the CCDA after signing the order unless you want to customize the document. When QIE picks up the order message, it automatically generates the TOC document and saves it to the patient chart, which logs the TOC order for Meaningful Use. It includes the CCDA in the message before sending.

Receiving TOC message with Centricity Clinical Messaging...

Check on the Desktop Messaging tab for received TOC documents and save the document to the patient’s chart. If there are clinical changes to reconcile, you can review and address them when you open the patient chart. See “Core Measure 14: Medication Reconciliation” on page 31.

When a TOC message is received, the CCDA document is attached in both XML and RTF formats. You can view and print or download and save to file. If you receive a TOC for a patient with an EHR chart in your system you can also save the document to the patient’s chart or create a new patient chart to receive it.
Receiving TOC message with Qvera (QIE)...

When a transition of care message is imported to the patient chart by QIE, a flag is placed on the Desktop of the provider to whom the document has been sent. The provider can open the patient chart and review the CCDA document and if necessary carry out required clinical reconciliation. See also "Core Measure 14: Medication Reconciliation" on page 31.

Reprinting / updating the Transition of Care CCDA

If you print the Transition of Care (TOC) CCDA and later wish to send an electronic version, you can either select the document using Centricity Clinical Messenger to send electronically, or you can regenerate the CCDA and save it to a file. If there have been no changes, the new TOC will be identical. You can also update the TOC to reflect recent changes by regenerating it. Clinical items retrieved for the TOC are always current and active.

Required permissions

Users must have existing permissions Chart > Export Summary Documents and Chart > Export Unsigned Observations to generate and send transition of care documents.

The existing Chart > Export Chart Summary permission is renamed Chart > Export Summary Documents. This permission is also required to generate and send Transition of Care documents. See “Core Measure 8: Clinical Summaries” on page 21. On upgrade, user permission assignments are maintained.
Core Measure 16: Immunization Registries Data Submission

**Measure:** Successful ongoing submission of electronic immunization data from CEHRT to an immunization registry or immunization information system for the entire EHR reporting period.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capability to submit electronic data to immunization registries or Immunization Information Systems and actual submission except where prohibited and in accordance with applicable law and practice.</td>
<td>Performed at least one test of certified EHR technology’s capacity to submit electronic data to immunization registries and follow up submission if the test is successful (unless none of the immunization registries to which the EP submits such information have the capacity to receive the information electronically).</td>
<td>Successful ongoing submission of electronic immunization data from Certified EHR Technology to an immunization registry or immunization information system for the entire EHR reporting period.</td>
</tr>
</tbody>
</table>

The application provides the following new features and workflows to support this measure:

- **New outbound submission method.** In prior releases, submission was supported using LinkLogic HL7 2.3 messaging and Centricity Clinical Gateway (Cloverleaf interface engine). In this release, outbound submission to a registry is handled by a subscription service running under JBoss that queues immunization information recorded in the application to picked up by your interface engine and sent in HL7 2.5.1 VXU messages to one or more configured registries. See “How do Meaningful Use subscriptions work?” on page 57.

  Qvera Interface Engine (QIE is GE’s preferred interface engine. Other transport mechanisms offering an MU 2014-compliant registry interface can be used but are not supported.

- **New immunization data model.** To support Meaningful Use 2014 edition reporting requirements, the application now stores all immunization administration data (previously stored in observation terms) to a new Immunization table, with a single row for each vaccine. Immunizations are now treated as clinical list items and follow rules for signed, filed in error, and discard and subject to clinical list locking. For details, see the guide Migrating and Managing Immunization Data.

- **Immunization data must be migrated to the new data model.** If you are upgrading, you must migrate immunization data to the new data model. This release includes a separately installed Migration Wizard tool. Running this tool preserves legacy observations and maps them to the new data model and standard codes.

  !!! Important: Mapping custom terms to the new model. If you have custom immunization observation terms, before migrating data, you must add these data to the mapping file immunizationmap.csv used to map existing observation terms and associated data to the new table.

- **New HTML-based Immunization Management form** stores data to the new table. If you are upgrading from a previous version, the legacy Immunization Management-GE form developed for the Meaningful Use Stage 1 release and custom forms based on that implementation all use observation terms to record immunizations. While these terms continue to be available in the
application, immunizations recorded using the older forms and terms will not be counted for Meaningful Use or reported correctly to a registry.

- Chart Summary reports now include immunization data from the new immunization table. If no data is found in the new table, the application also pulls immunization data that was recorded using observation terms from previous versions of the software.

  If you have immunization data recorded in observation terms, they should be migrated to the new Immunization table. The Immunization Management form can display a patient's immunization history, but only when the data is in the new table.

  Before you migrate your data, all providers should be prepared to use the new form (or a custom form modified to store immunization values to the new table).

- Set up Immunization Custom Lists in Administration to use with Immunization Manager form.

- Use Registration > Registry tab to set patient registry status and preferences.

Using Migration Wizard

The Migration Wizard is used to migrate previously recorded immunization data into the CPS 12.0 data model for immunizations. The tool is easy to use and can be run at any time after installation or upgrade. You can run the tool more than once, in case clinicians inadvertently continue to use the old encounter form during the transition. In subsequent migrations, only non-migrated data is moved. A migration can also be stopped and started again without risk to your data.

- After you’ve migrated your immunization data to the new schema, clinical users must be careful not to record an immunization’s administration in both the legacy Immunization encounter form and the new HTML encounter form. If they do the data will be erroneously duplicated if you run the migration a second time.

For detailed migration instructions, see Migrating and managing immunization data in Centricity Practice Solution v12, packaged with the tool.
**Using new Immunization Management HTML form**

This new form uses MEL symbols to capture immunization data in an HTML form and includes the following workflows and features:

- Add, update, remove, and list immunizations and vaccine groups.
- View patient immunization easily in graphical grid display with icons that indicate immunization details.
- Use custom lists defined in Administration provide logical groupings of immunization types.
- Use VFC eligibility questionnaires.
- View results of interaction checking.
- Add allergies based on any adverse reactions.

---

**Important:** If you previously created custom immunization observation terms, and you are migrating data, you must add these data to the mapping file, immunizationmap.csv, which is used to map existing observation terms and associated data to the new table.

---

The Immunization Management and Medication Administration forms display interactions during an update, but do not support interaction override. You can enter your override reason in the form comment section if you want. To capture this information in the chart, add the medication to the Medication list and enter the override and reason when the interaction alert appears.
Using Immunization Custom List

To use the new Immunization encounter form, you must first set up and populate Immunization Custom Lists in Administration under Chart.

1. Click New and name a new custom list.

2. Click Add New Vaccine Group to add medications. Edit window opens automatically after Add.

3. Add/change relevant details and click OK.
Core Measure 16: Immunization Registries Data Submission

Using Registration > Registry tab to set patient registry status and preferences

The Registration > Registry tab displays active registry subscriptions for a patient. You can edit the patient’s relationship with the registry using list options that meet Meaningful Use requirements. You can edit list options in Administration > Registration > Registry:

- **Opt-Out** — opt out the patient from the registry and enter the method they used to request opt out and reasons.
- **Opt-In Method** — indicate how the patient was enrolled, such as a verbal request or auto-enrollment when the registry subscription was configured.
- **Publicity Code** — indicate patient’s preference for notification (recall or reminders) when data is transmitted to the registry and date authorized.
- **Protection Indicator** — indicate patient’s privacy preference for disclosure of the data to other clinicians and date authorized.
- **Immunization Registry Status** — indicate the patient’s status with the registry, such as Active or Inactive and date status was updated.

New and changed MEL symbols for Immunization Registries Data Submission

The following new symbols support Immunization Registries Data Submission: IMMUN_GETLIST, IMMUN_ADD, IMMUN_UPDATE, and IMMUN_REMOVE are used to display and modify data in the Immunization Management Form. See also "New and changed MEL data symbols" on page 69.
Core Measure 17: Use Secure Electronic Messaging

**Measure:** A secure message was sent using the electronic messaging function of CEHRT by more than 5 percent of unique patients (or their authorized representatives) seen by the EP.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use secure electronic messaging to communicate with patients on relevant health information.</td>
<td>None - NEW in Stage 2.</td>
<td>A secure message was sent using the electronic messaging function of Certified EHR Technology by more than 5% of unique patients seen during the EHR reporting period.</td>
</tr>
</tbody>
</table>

**Available v12.1.** GE supports secure messaging with patients and Meaningful Use reporting to this measure with separately-licensed Centricity Secure Messenger and Patient Portal.

For information about licensing and implementing Patient Portal and Secure Messaging, contact your GE Sales representative or your Value-Added Reseller.

When the patient sends a message via the Kryptiq SMPP (Secure Messaging Patient Portal), a record is created in the MU Activity Log - this ensures that the patient’s message counts towards this measure.
Menu Measure 1: Syndromic Surveillance Data Submission

**Measure:** Capability to submit electronic syndromic surveillance data to public health agencies except where prohibited, and in accordance with applicable law and practice.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capability to submit electronic syndromic surveillance data to public health agencies and actual submission except where prohibited and in accordance with applicable law and practice.</td>
<td><strong>Performed at least one test</strong> of certified EHR technology’s capacity to provide electronic syndromic surveillance data to public health agencies and follow-up submission if the test is successful (unless none of the public health agencies to which an EP, eligible hospital or CAH submits such information have the capacity to receive the information electronically).</td>
<td><strong>Successful ongoing submission</strong> of electronic syndromic surveillance data from Certified EHR Technology to a public health agency for the entire EHR reporting period.</td>
</tr>
</tbody>
</table>

The application sends information entered in the Urgent Care form to a configured public agency when the document is signed. Exclusions include organizations that do not provide urgent care/emergency services or that operate where submission is not supported by public health agencies capable of receiving the information.

The application provides the following new features to support submission:

- **Urgent Care encounter form** to enter required values/codes (required).
- **Public Health Registry subscription** configured in Administration works with your interface engine to send HL7 ADT 03 and ADT 04 (Admit/Discharge) messages to one or more configured agencies. See “How do Meaningful Use subscriptions work?” on page 57. Also refer to “Configuring data exchange for Meaningful Use 2014” in your Managing Interfaces guide for details.

Qvera Interface Engine (QIE) is GE’s preferred interface engine for this release. Other transport mechanisms offering an MU 2014-compliant registry interface can be used but are not supported.
Urgent Care Management encounter form

This form carries forward chief complaint and vitals if entered elsewhere during the visit and includes values required for HL7 Admit/Discharge message. Includes Triage tab with field for free text notes and Disposition tab with standard discharge disposition options required by registry.

Menu Measure 2: Electronic Notes

Measure: Enter at least one electronic progress note created, edited and signed by an EP or authorized provider for more than 30 percent of unique patients with at least one office visit during reporting period. The text of the electronic note must be text searchable and may contain drawings and other content.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record electronic notes in patient records.</td>
<td>None. New for Stage 2.</td>
<td>Enter at least one electronic progress note created, edited and signed by an EP for more than 30 percent of unique patients with at least one office visit during the EHR Measure reporting period. The text of the electronic note must be text searchable and may contain drawings and other content.</td>
</tr>
</tbody>
</table>

This new Stage 2 requirement is met by the application. All signed chart notes for a patient seen by the provider in the office at least once during the reporting period are counted.
Menu Measure 3: Imaging Results

**Measure:** More than 10 percent of all tests whose result is one or more images ordered by the EP during the EHR reporting period are accessible through Certified EHR Technology.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Imaging results consisting of the image itself and any explanation or other accompanying information are accessible through CEHRT.</td>
<td>None. New for Stage 2.</td>
<td>More than 10% of all scans and tests whose result is an image ordered by the EP for patients seen during the EHR reporting period are incorporated into or accessible through Certified EHR Technology.</td>
</tr>
</tbody>
</table>

For this new Menu measure, imaging results consist of the image itself and any accompanying explanation that are accessible through the application as attachments to a chart document stored in the database or as links in a document to an external storage location that permits the user to open and view the images from the application. The application has the ability to store and link to images already; in this release a mechanism for counting accessible results is provided using the document type **Imaging Report**.

The application checks for an Image Report document type, and then counts its presence in the document as either a link to the image on an external site or as an attachment.
Menu Measure 4: Family Health History

**Measure:** More than 20 percent of all unique patients seen by the EP during the EHR reporting period have a structured data entry for one or more first-degree relatives.

<table>
<thead>
<tr>
<th>Stage 1-2 objective</th>
<th>Stage 1 measure</th>
<th>New in Stage 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record patient family health history as structured data.</td>
<td>None. New for Stage 2.</td>
<td>More than 20% of all unique patients seen by the EP during the EHR reporting period have a structured data entry for one or more first-degree relatives or an indication that family health history has been reviewed.</td>
</tr>
</tbody>
</table>

In this release, Family History information is enhanced to meet Meaningful Use requirements for more detailed structured data for relationship-specific condition histories. New features and workflows in Family History/Social History-CCC form that supports the measure include:

- Select from list of level-one Relationships.
- Add, revise, or remove Family History items.
- Apply/revise Comments to one or several conditions for a single relationship.
- Select Reviewed, no changes required, No Known Family History, and No Known Relative.
- Family history information previously stored in observations terms displays in Comment section of the form and can be added as structured data in the form.
Enhanced Family History/Social History-CCC encounter form

Family History Summary section contains all family history details.

When a family history item is added to the form, a family history problem is also added to the patient's chart.

New and changed MEL symbols for Family History

The following new symbols support Family History: MEL_RELATIVES_FHX, MEL_LIST_FHX, MEL_LIST_FHX_AFTER, MEL_LIST_FHX_NEW, MEL_ADD_FHX, MEL_UPDATE_FHX, and MEL_REMOVE_FHX are used to display and modify Family History in the form. See also "New and changed MEL data symbols" on page 69.
Report Functional Measures and Clinical Quality Measures (CQMs) to CMS

With this release, Meaningful Use reporting and clinical quality reporting (Stage 1 and Stage 2) are handled by Centricity Quality Reporting, a Web-based solution that receives providers' measure calculation data continuously from the application and calculates and reports measure performance.

For detailed information about functional measure and clinical quality measure calculation and reports see Achieving Meaningful Use with Centricity Practice Solution available in your Centricity Document Library. This updated user guide is available in both PDF and HTML formats for Stage 1 and Stage 2 reports.

Report clinical quality measures (CQMs) to CMS or the States

Providers must select at least 9 CQMs, including 3 or more from National Quality Strategy Domains, and submit to CMS or the States. Out of 64 measures, we offer 27 in this release. For detailed information about each measure and how to ensure you are capturing the correct data, see Achieving Meaningful Use with Centricity Practice Solution. The following CMS measures are currently certified for this release. Additional measures may be certified at general release.

### Clinical Quality Measures - 2014

- CMS69 Preventive Care and Screening: Body Mass Index (BMI) Screening and Follow-Up
- CMS117 Childhood Immunization Status
- CMS125 Breast Cancer Screening
- CMS126 Use of Appropriate Medications for Asthma
- CMS138 Preventive Care and Screening: Tobacco Use: Screening and Cessation Intervention
- CMS147 Preventive Care and Screening: Influenza Immunization
- CMS148 Hemoglobin A1c Test for Pediatric Patients
- CMS165 Controlling High Blood Pressure
- CMS166 Use of Imaging Studies for Low Back Pain
**New reporting solution (Centricity Quality Reporting)**

New Web-based Centricity Quality Reporting solution calculates measures using provider data continuously collected and sent from the application. You'll register your organization as a member on the CQR Web site and set up your providers to view Meaningful Use performance for the measures they are attesting to on the site.

**Getting started with Clinical Quality Reporting (CQR) services**

To begin sending Meaningful Use data to the Clinical Quality Reporting Web site, you must set up and enable the **Send Data for Clinical Quality Reporting** and **Send data for Functional Measures Reporting** subscriptions in the application and in your interface engine. See "Configuring Meaningful Use 2014 subscriptions and HL7 messages" in your **Managing Interfaces** guide for details.

**Register as a member organization...**

On the CQR Web site you'll register your organization with CQR. You can access Member Registration from the **CQR Register Member** link in Administration.

https://cqr.gehealthcare.com/memberRegistration

Once your Member registration is confirmed by GE, you can log in and begin setting up your providers to view their progress against measures. You’ll carry out the following steps (detailed help is available on the Web site):

**Create an organizational structure...**

On the site, you can represent locations and practices within your enterprise and organize providers under them. If you have a single location/practice with many providers, you can also use the Web features to organize providers into manageable groups. This step will help your Quality Champions quickly drill down to individual provider quality dashboards to view their progress.
Upload provider information to CQR...

Before you can register individual providers with CQR to give them access to their reports, you must export provider information to the CQR Web site. This export of patient and provider information is accomplished from the Clinical Inquiries module. This step is also necessary to initialize reporting for Functional and Clinical Quality measures, so relevant patient data can be sent for analysis to the site.

Organize providers on the site....

Once provider information is uploaded to the Web site, you can log in and drag and drop providers into the organizational structure you created previously.

Set up provider Reporting Dashboards...

After a provider or other authorized user is registered, they can see their Provider Reporting Dashboard when they log in. (See screenshot above).

By default all measures for Stage 1 and Stage 2 and all CQM measures display in the Reporting Dashboard. If the provider has any data in the system, calculations are made automatically and progress to measures displays. An administrative user or Quality Champion can remove measures from the display that are not relevant for the provider by changing the provider's Measurement Settings.

Register providers/users to access Clinical Quality Reporting....

To grant providers access to the site, in Administration, click Application Users in the ribbon menu, then select a user, click Edit, and open the CQR Registration tab. You’ll enter some basic credentials, including creating a login and password for the provider, then submit the request for Access to CQR. The Administrator for your site or Quality Champion must log in and approve each user request.

Once a user is registered, you can create additional accounts for individuals the provider wants to be able to access the Dashboard, such as nurses, medical assistants, students, and so on. Access the main login screen and select Create a New Account under the login fields.
Global features support Meaningful Use 2014 edition reporting

Global features and enhancements support the application in capturing and reporting all Meaningful Use functional and quality measure data.

- **CCDA-compliant document format.** All documents and messages generated for communicating clinical information to patients, providers, and for Meaningful Use functional measure reporting conform with CCDA or Consolidated Clinical Document Architecture standard as required for Meaningful Use.

- **Common Event Model architecture.** In this release enhanced architecture supports continuous, system-wide identification of events that contribute to Meaningful Use measures and continuous queuing and sending of data for analysis and reporting to new Web-based Clinical Quality Reporting services. Based on qualifying events such as document or clinical list signature, data that contributes to Meaningful Use calculations is logged, queued, processed (to apply required formatting), and then retrieved daily by your interface engine. From there the data is sent for analysis to the Clinical Quality Reporting site.

- **MUActivityLog.** Beginning in this release, the **MUActivityLog** records event details needed for Meaningful Use numerator or denominator calculations. For Meaningful Use events that occurred before upgrade, such as encounters counting towards the **Seen By** denominator, the information might be stored in other tables, but is still used as part of measure calculations.

How do Meaningful Use subscriptions work?

Outbound subscriptions rely on interfaces provided by your interface engine to pull queued data from the application database, put it in a format that can be consumed by an external system, and send the data to that system.

For each subscription, Centricity Services will help you configure your interface engine to communicate with the external system. Part of the configuration is done within the application and part within the interface engine.

For detail of the implementation process, see “Configuring data exchange for Meaningful Use 2014 subscriptions and HL7 messages” in *Managing Interfaces with Centricity Practice Solution*.

Available subscriptions

Subscriptions include:

- **Export Charts from Patient List** — Sends a group of patient charts identified in the Inquiries module in to a designated endpoint outside your system. The interface pulls and formats patient charts returned in an Inquiry in CCD/CCDA format and stores the files to a folder you specify. You can then package and move the files to a location where another system can access and import the charts. For detailed instructions, click F1 in the Inquiries module.

- **Send Data on Quality Measures** — Collects and sends provider data for Meaningful Use Phase 1-2 Quality Reports to Centricity Quality Reporting Web site for analysis. The interface pulls patient data from the application database and sends to CQR in CCDA format for CQM reports.
**What’s New in Centricity Practice Solution 12**

- **Send Data for MU Reporting** — Collects and sends provider data for Meaningful Use Phase 1-2 Reports to Centricity Quality Reporting Services. The interface pulls patient data from the application database and sends to the CQR site in JSON format for Meaningful Use functional measure reports.

  **Important.** This subscription also requires a second step to initialize reporting services. See note for Clinical Quality Measures reporting above.

- **Send Data to Immunization Registry** — Sends patient immunization data to one or more configured immunization registries. Your interface engine pulls patient data from the application database and sends in HL7 2.5.1 VXU messages.

- **Send Data to Public Health Agency** — Sends patient information to one or more configured public health agencies. The interface pulls patient data from the application database from configured urgent care locations and sends in HL7 2.5.1 ADT03 and ADT04 messages.

**Enabling subscriptions in the application**

In the application, subscriptions are managed in Administration at **System > Interoperability > Configuration**, where you can import and enable subscriptions. You must also configure the corresponding subscription interface in your interface engine.)

---

**Outbound Subscriptions**

<table>
<thead>
<tr>
<th>Name</th>
<th>Activity</th>
<th>Format</th>
<th>Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meaningful Use Functional Measures Reporting</td>
<td>Send MU2 Measures Data</td>
<td>CEMU2</td>
<td>No</td>
</tr>
<tr>
<td>Clinical Quality Measures Reporting</td>
<td>Send Data for MU Reporting</td>
<td>CCDA</td>
<td>No</td>
</tr>
<tr>
<td>Immunization Registry</td>
<td>Send Data to Immunization Registry</td>
<td>VXU</td>
<td>Yes</td>
</tr>
<tr>
<td>Public Health Registry</td>
<td>Send Data to Public Health Agency</td>
<td>ADT</td>
<td>No</td>
</tr>
<tr>
<td>Data Portability</td>
<td>Export Charts from Patient List</td>
<td>CCDA</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Details for: Clinical Quality Measures Reporting**

- **Content:** CCDA
- **Schedule:** Scheduled event processing
- **Interface Engine pulls from Outbound Queue:** jms.queue:Clinical Quality Measures Reporting.outbound.queue

Click **Import Subscription** and select subscription. Click **Enable** to begin queuing data.
Changes in clinical terminology data model

All required Meaningful Use terminologies are supported in CPS 12. These terminologies include the following:

<table>
<thead>
<tr>
<th>This terminology is used...</th>
<th>In these application components...</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNOBED CT</td>
<td>• Problems</td>
</tr>
<tr>
<td></td>
<td>• Family History (including relationship)</td>
</tr>
<tr>
<td></td>
<td>• Smoking Status</td>
</tr>
<tr>
<td></td>
<td>• Procedures</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: SNOBED-CT codes do not display in the User Interface, but are mapped in the database and are visible in the C-CDA.</td>
</tr>
<tr>
<td>LOINC</td>
<td>Observations: Lab Results, Vital Signs, and more</td>
</tr>
<tr>
<td>RxNorm</td>
<td>• Medications</td>
</tr>
<tr>
<td></td>
<td>• Medication Allergies</td>
</tr>
<tr>
<td></td>
<td>• eRx NCPDP 10.6</td>
</tr>
<tr>
<td>CVX</td>
<td>Immunizations (added MU Stage 1)</td>
</tr>
<tr>
<td>MVX</td>
<td>Immunizations (added MU Stage 1)</td>
</tr>
<tr>
<td></td>
<td>Administered Medications (added Stage 2)</td>
</tr>
<tr>
<td>ICD-9, ICD-10, CPT, HCPCS</td>
<td>Legacy usage and MU 2014.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong>: Only ICD-10 is covered for Meaningful Use Stage 2.</td>
</tr>
<tr>
<td></td>
<td>CPT are used to identify office visit, procedures, imaging, lab orders, and so on</td>
</tr>
<tr>
<td></td>
<td>For customers who do not use our Orders module, order-related information can be mapped from appropriate Observations to SNOBED-CT or CPT codes.</td>
</tr>
<tr>
<td>UCUM, UNII</td>
<td>Units of Measure, Non-medication allergies</td>
</tr>
<tr>
<td>ISO, OMB</td>
<td>Language (ISO)</td>
</tr>
<tr>
<td></td>
<td>Race and Ethnicity (OMB)</td>
</tr>
</tbody>
</table>

For Meaningful Use Stage 2, Medi-Span is also included to support formalized interaction checking on immunizations, not required previously. See "Expanded support for allergies and drug interaction checking" on page 19.
Mapping data for Meaningful Use

To support CQM and Meaningful Use reporting, GE provides mappings for all observation terms (numeric and string values) to expected codes in value sets required by CMS and ONC.

**What are value sets?**

Lists of specific values (terms and their codes) derived from standard vocabularies that define clinical concepts such as patients with diabetes, clinical visit, reportable diseases. In Meaningful Use reporting, value sets are used to define patient populations to be included in denominators and numerators when computing a clinical quality measure.

For more information, go to https://vsac.nlm.nih.gov/.

This mapping ensures that data captured in the application is sent for reporting or other purposes in standard codes and values and that all your data is included in measure calculations.

No mapping is required for Problems, Medications and Allergies, because these values are already stored to values expected by CMS and ONC.

Custom observations and order codes created for your site will not be counted unless they are also mapped to the required codes. You can use the Data Mapping tool located in Administration under Codes > Settings > Data Mappings to creates these mappings locally for your site.

**Using the Data Mapping tool**

On this tool you can see which codes are expected by CMS and ONC for different measures and which observations have already mapped to those codes. You can also identify unmapped terms and map them to a selected code.
To start the search/mapping process, double-click a value-set code you want to map observations to. On the Data Search tab, you can then search for relevant observations and map them to the selected code.

In the following example, a search for observations with string "diab" returned a number of unmapped observation terms to consider mapping to the selected code. Pre-mapped values appear in italics and cannot be modified; regular entries can be mapped, changed, or removed.

Use **Data Type Filters** to limit values returned.

Use **Frequency Filters** to limit returned values to most often used (100 is default) or to limit date range of search (3 months is default).

Select an entry and click **Add Mapping** to map to the **Selected Data Code**.

Mappings done on this view are for the **Selected Data Code**.
Data Portability - exporting patient charts from Inquiries module

When a provider moves to another healthcare system, you can find and export patient charts to the new system. To access this feature, you must have an active Data Portability subscription enabled and configured in Administration. You must also have the Inquiries/Reports > Export Patients permission.

Charts sent from the Inquiries module are exported in CCDA format to the interface engine where they can be packaged and distributed to an external system. When the export is successful, a confirmation appears.

Set up an inquiry to find the set of patients you need to send.

Run the inquiry and check your results.

Select Export Patients in Activity list.
**MU Core Checklist encounter form**

This new form is part of the CCC Basic available with the product. Open this form during a chart update to check the visit for clinical information relevant to key Meaningful Use measures that you might have overlooked.

Missing clinical list items, orders, vital signs, and smoking status can be added directly from this form. You can also do Clinical Reconciliation and generate a Clinical Visit Summary for the patient directly from the form. If a Transition of Care document needs to be generated, this form notifies you and provides a link to jump to the Orders module to complete.
Support for interface engines

With this release, Qvera Interface Engine (QIE) is the preferred transport mechanism for Meaningful Use 2014 reporting. Qvera and GE offer and provide direct support for interfaces for all Meaningful Use messaging/reporting. Qvera and relevant interfaces are available directly from GE. Contact your sales representative for additional information.

You may use any interface engine that offers MU2014 compliant interfaces that work with application subscriptions, but GE Support will only take QIE calls. Qvera will provide second tier support.

If you are upgrading to this release and using an unsupported interface engine, contact Centricity Services for information about its compatibility with this release and for help transitioning your existing interfaces to Qvera.
Other enhancements

Performance and scalability and ease of use has been improved by more tightly integrating Administration and Chart.

Chart and Administration run together now

With this change, aimed at significantly reducing load time, the application opens and switches from module to module more quickly. You can also now access all modules from the new left navigation in Chart and Administration rather than switching to the main application menu as in the past.

After upgrade, your Dragon® voice recognition software custom keyboard shortcut commands might need to be edited. Although keyboard shortcuts have not changed, some actions are now accessed through new menu navigation paths.

“Where do you want to go?” Left navigation provides access to all modules

When Administration or Chart are open you access functional features in the ribbon Home menu above and all other application modules from the left navigation pane. This view shows how it looks from Administration. For Chart view navigation changes, see “In the Chart module, the Options tab displays items previously under the Options menu.” on page 67.

“What do you want to do?” Administration Edit and Chart Action items moved to Home on ribbon

Like Microsoft Outlook®, the ribbon Home menu offers easy to use visual groupings of commonly used features for Administration and Chart. For example, in Administration, all items alphabetized under the Edit menu list in previous releases are now grouped for easy access on the ribbon by function and frequency of use. See illustrative examples, on the next page.
Some additional links make it easy to jump directly to commonly used setup areas with a single click, for example, to user and security setup and LinkLogic task options.

**Main Application Functions** — These are features configured across Chart and Practice Management, such as User setup and management, Security, Appointment Types, Insurance, Facilities, Registration Maintenance, and so on.

**Financial Functions** — These are configuration features important to the financial side, such as Batches, EDI and Plugins, Inventory and Charge Maintenance (which includes charge sets and related features such as allocation sets, diagnoses, sliding fee schedules, and so on).

**Clinical Functions** — configuration features for the clinical side, including Pharmacies and LinkLogic Task Options.

Related features for a functional group are in easy reach in drop-down menus. Here are some examples.
Chart and Administration run together now

**Chart and Chart Desktop Actions menu items move to Home menu**

Similarly, in the Chart module’s Chart and Desktop views, the ribbon Home tab menu includes all Tool bar and Action drop-down list items in previous versions.

As on the Administration ribbon, available actions are grouped and labeled in functional categories such as Search, Alerts/Flags, Update, or Documents.

Different action icons display depending on the view.

**Other ribbon features for Administration and Chart**

Access left navigation module options from the File tab menu. For Chart module, this includes all the Go menu items accessing other modules. Click the down/up arrow at the top right of the ribbon to hide/show ribbon menu items.

In the Chart module, the Options tab displays items previously under the Options menu.
**Custom links and commands**

This update allows users with the appropriate privileges to create custom HTML links in the left navigation pane and custom commands in the ribbon menu that execute batch or system commands.

The following image shows the user privileges required to access this feature:
New and changed MEL data symbols

The following new and changed MEL symbols are included in this release.

New MEL data symbols

Allergies:

- **MEL_CHANGE_ALLERGY** — Gives encounter form developers the ability to display changes to allergies in a custom encounter form.
- **MEL_REMOVE_ALLERGY** — Gives encounter form developers the ability to remove an allergy from a patient’s allergy list in a custom encounter form.

Care Plans:

- **MEL_LIST_CARE_PLAN** — Lists care plan details based on the specified values. You can format the details into a list with one care plan per line or separate the details with commas.
- **MEL_ADD_CARE_PLAN** — Adds patient care plan information to the patient’s chart.
- **MEL_UPDATE_CARE_PLAN** — Allows users to update existing patient care plan information in the patient’s chart.

Documents:

- **DOCUMENTTORECONCILE** — Returns the number of new or partially reconciled external documents for the selected patient. This data symbol is used as a notification in the patient’s chart that there are clinical list items (problems, medications, and/or allergies) that need to be reconciled.
- **GET_RECONCILE_DOC_LIST** — Displays a list of external documents, in delimited format, that need to be reconciled.

Family History:

- **MEL_RELATIVES_FHX** — In the Family History form, this returns a list of all patient family members. Includes the following information: FHXRelID, Relation, Degree, Description, Code, Code Type, and Gender where relevant.
- **MEL_LIST_FHX** — Returns a list of all signed FHx records for a patient.
- **MEL_LIST_FHX_AFTER** — Returns a patient’s family history (FHX) data; this includes both signed and unsigned information.
- **MEL_LIST_FHX_NEW** — Returns a list of all patient family history information updated during the current chart update.
- **MEL_ADD_FHX** — Adds a new family health condition to a patient’s chart.
- **MEL_UPDATE_FHX** — Allows users to edit an existing family health condition for a patient’s family member.
- **MEL_REMOVE_FHX** — Allows users to remove an existing family health condition for a patient’s family member.

Immunizations:

- **IMMUN_GETLIST** — Lists active immunizations recorded for the patient; one record per immunization.
- **IMMUN_ADD** — Allows users to add a new immunization to the patient’s chart.
What's New in Centricity Practice Solution 12

- **IMMUN_UPDATE** — Allows users to update existing immunizations in the patient's chart.
- **IMMUNREMOVE** — Removes an immunization from a patient's chart.

Other:
- **GET_MUACTIVITY_LOG** — Used in encounter forms to retrieve entries related to a document from the MU Activity Log table. For example, this symbol is used in the MU Core Checklist form (CCC Basic) to display whether a Clinical Visit Summary is provided to the patient or declined.
- **MEL_CHANGE_MEDICATION** — gives encounter form developers the ability to change to medications on a patient's medication list from within a custom encounter form.
- **MEL_REMOVE_MEDICATION** — gives encounter form developers the ability to remove medications on a patient's medication list from within a custom encounter form.
- **MEL_GEN_CVS** — Launches the Clinical Visit Summary window, which generates a CCDA format version of a selected visit document for a patient that can be customized and printed or saved to a file to be given to the patient.
- **MEL_USER_PRIVILEGE** — Determines whether the current user has an appropriate access privilege/permission within an encounter form.
- **PATIENTCONTACTBY** — Returns the patient's contact by information.

Updated MEL data symbols

- **ALL_AFTER** — Two new fields are available in delimited output: AID (allergy ID) and last modified date.
- **MEDS_AFTER** — Two new fields are available in delimited output: Last refill date, and last modified date.
- **MEDS_PRIOR** — New value added to delimited output: MID (Medication ID).
- **PROB_AFTER** — New field added to delimited output: Last modified date.
- **PATIENT.RACE** — Returns up to two race values depending on the value(s) entered for Race in the Registration Patient tab. These values are pulled from the values defined in Administration for Race or Race Subcategory.
- **PATIENT.ETHNICITY** — Returns the patient Ethnicity value entered in patient registration. This value is pulled from the values defined in Administration for Ethnicity or Ethnicity Subcategory.
New/Changed Clinical Content

This release includes a new CCC Basic package that replaces the legacy Basic Practice content that is deprecated in this release.

CCC Basic includes 25 core forms drawn from the separate larger CCC forms package. Each form has been updated with all required capabilities for Meaningful Use. New features include, for example, added clinical decision support, ability to capture more detailed family history, and risk factors for smoking for Vital Signs.

If you already license the full CCC forms package, install the CCC Basic package to update relevant CCC forms and add new content for Meaningful Use.

**Upgrade to v8.3.8 before installing the CCC Basic package.** The next full release for the CCC package (v9) will update all relevant forms for Meaningful Use and will be available in 2014.

The CCC Basic package includes the following forms:

- HPI-CCC
- HPI-Spec Specific Editor
- Vital Signs-CCC
- PMH-PSH-CCC
- FH-SH-CCC
- ROS-CC
- PE-CCC
- Problems-CCC (Reconciliation Included)
- Risk Factors-CCC
- Hypertension-CCC
- CPOE A&P (Care Plan Included)
- Serial Assessments
- Test Management-CCC
- CDSS Contraindications
- Patient Instructions-CCC
- CCC-Text File Editor
- MU Core Checklist (Reconciliation Included)
- Entry-CCC
- Entry-CCC Text File Editor

**New HTML5 forms:**

- Immunization Management-CCC
- Medication Administration
- MU Quality Dashboard
- Urgent Care Management
- Care Plan portion of the CPOE A&P form

Refer to the separate release notes for this package for detailed information about installation, use, and customization.

**CCC Basic feature highlights**

In all relevant forms, the “Select Specialty” drop-down displays only Family Practice and Family Medicine.

**CPOE A&P-CCC form**

- Enhanced clinical decision support "Core Measure 6: Clinical Decision Support" on page 16.
- Ability to view and reconcile a patient problems, medications, and allergies.
- Allergy GPI codes and gender can now be added in addition to observation terms to turn off a treatment deficiency prompt to facilitate drug and allergy interventions. These are configurable in the CCCQE-User-Edit-PSIA-Adult.txt file or the Tx Deficiency Editor-CCC form.
- New Care Plan section. See "Documenting Care Plans" on page 72.
FH-SH-CCC and Risk Factors-CCC forms

- Support for new Smoking Status requirements. See “Core Measure 5: Record Smoking Status” on page 14.
- Support for new Family History requirements. See “Menu Measure 4: Family Health History” on page 52.

MU Core Checklist (Reconciliation Included)

Open this form during an update to check the visit for clinical information relevant to key Meaningful Use measures that you might have overlooked. See “MU Core Checklist encounter form” on page 63.

New HTML5 forms

- **Immunization Management** — See “Using new Immunization Management HTML form” on page 45.
- **Medication Administration** — See “Administered Medications form” on page 6.
- **Urgent Care Management** — See “Urgent Care Management encounter form” on page 50.
- **Care Plan** portion of the CPOE A&P-CCC form (see below)

Documenting Care Plans

A care plan is a goal with instructions relevant to a specific problem. You are not required to use care plans to meet Meaningful Use requirements; however, if a care plan is used, it will be included in the CCDA. On the CPOE A&P-CCC form, click **Add** to enter a new care plan for a problem or select a problem with a care plan and click **Update**.

You can set predefined goals and instructions for a given problem by configuring a text component called “Care Plan - Configuration Data” included in the CCC Basic package. For detailed instructions, see CCC Basic Release Notes available with the package.

New and changed MEL symbols for Care Plans

The following new symbols support Care Plans: MEL_LIST_CARE_PLANS, MEL_ADD_CARE_PLANS, and MEL_UPDATE_CARE_PLANS.